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Introduction 

Aspen (Atmospheric Sounding Processing Environment) is used for analysis and quality 
control (QC) of sounding data. It has the following capabilities: 

• Automatically apply quality control procedures to the sounding data 

• Present data in tabular and graphical forms 
• Automatically determine levels and code them in WMO message formats 

• Transmit the WMO messages to other systems 
• Save the raw and derived data products in various formats 

Since Aspen can process data provided in the AVAPS “D” file, NCAR GLASS, NCAR 
MCASS and NCAR CLASS formats, it is able to analyze both dropsonde and upsonde 
soundings. 
Aspen is designed to operate as automatically as possible, while allowing the user to have 
some control over the QC methods. For instance, as soon as the user selects a sounding 
file for processing, the data is brought into Aspen and automatically analyzed. In most 
cases this first pass will be the only one required. If the processing needs to be modified, 
the user can change the QC parameters and reprocess the data as many times as 
necessary. 
An extensive series of QC algorithms are applied to the data. These algorithms typically 
have one or two parameters that may be adjusted by the user if the default values are not 
suitable for a particular sounding. The user can save the modified options, so that when a 
new sounding is opened, the initial analysis will use the customized QC parameters. 
Aspen can have up to six sounding files open at the same time. This makes it convenient 
to compare soundings.  
Aspen is designed so that its operation requires minimal user intervention. However, 
there are a few concepts that are very helpful in understanding the behavior of the 
program. 

 
Aspen maintains two separate data sets: the raw data and the QC data. 
At the start of processing, the QC data is an exact copy of the raw 
data. The algorithms are then successively applied to the QC data. As 
the processing proceeds, data points that fail each test are removed 
from QC data set. At the end of this process, a final smoothing is 
applied to the remaining QC data. It is important to understand that 
nearly all of the QC steps simply remove unreliable points from the 
raw data set. The dynamic adjustments and the final smoothing are 
the only steps where the observed data values are actually modified. 

 

The QC 
process 
mainly 
removes 
suspect 
data points 
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A sounding is simply a time series of observations, and so almost all 
of the QC operations are based on the time of each data point. The 
QC parameters are specified in relation to time, and the tabular data 
listings are ordered by time. 

 
The complete processing routine is applied as soon as a sounding is 
selected for analysis, and whenever the user chooses to recompute the 
analysis. The sequence is as follows: 

1) Apply the QC algorithms, discarding bad points and 
applying corrections 

2) Compute the levels, by analyzing the QC results. 
3) Code the WMO message, using the levels as input. 

 
Throughout this manual, notes in italics provide additional information and suggestions 
which, while not essential to operation, will help you use Aspen more effectively. 

Time is the 
independent 
variable 

The 
processing 
follows a 
fixed 
sequence 
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Overview of Operation 

To run Aspen, double click on the Aspen icon , or choose Aspen 
from the start menu. An initial start screen will appear. If the file 

selector does not appear immediately, choose Open under the File menu:  

 

 
 
You will now see the file selector: 
 

 

 
 
The file selector is used to choose the sounding file to be processed. You can move to 
other directories using the up directory button or the directory chooser. The file filter 
controls the file types that are displayed in the chooser. 

If you do not see your data files in the directory where they are supposed 
to be, it is probably because the file filter is set incorrectly. Change the file 
filter to “All files (*.*)” in order to display all files in the directory. 

 

Directory chooser 
 Directory chooser 

 

Up directory 

File filter 

1 Run 

File menu 
 Directory chooser 
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Select the file containing the sounding that you want to analyze. 
Click once on the file and then press “Open”, or double-click the file 
name.  

Aspen will show a warning message if you select a file that is in a format 
which it can’t process. 

Processing of the sounding begins as soon as the file is opened. The progress of the 
analysis is displayed in the status box in the lower left hand corner of the main screen, but 
until the processing is complete, the screen will remain blank. 

When the sounding analysis has completed, the initial screen will be filled with a tab-
based display, in which each tab represents a different view of the data. The tabs are 
arranged from left to right (see figure below) in the general order of the data processing, 
i.e. from raw data, through the QC and levels computation, to the coded message. Read 
the Tab Displays section for further description. 

 
 

Verify the sounding by examining all of the tab selections. Read  the 
Post-Processing Adjustment section for important guidelines on 
doing this. After examining the sounding, the user may decide that 
one or more of the processing parameters should be adjusted.  

 

The most commonly altered processing parameters can be 
changed on the Main tab. When they have been set to the 
desired values, press the Recompute button on the Main Tab 

to reanalyze the sounding using the new parameters. The processing status will again be 
displayed in the lower left status box. When completed, the displays in each tab will be 
updated with the new results. 

Be sure to press the Recompute button after changing the processing 
parameters; otherwise, the new parameters will not be applied to the 
sounding. 

To analyze another sounding, open another data file 
using the FileOpen menu. Many soundings can be 
open at one time. Use the Window menu to choose 
which sounding is displayed. 

2 

3 

4 

5 

Open 

Next Sounding 
 

Recompute 
(if necessary) 

Verify 
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Post-Processing Adjustment 

Once a sounding has been processed by Aspen, the results must be examined carefully. 
Frequently some parameters will need to be adjusted to compensate for characteristics of 
the data.  

End of data 
In a well-behaved sounding, the end of the raw data set will occur at the end of the 
sounding. For a dropsonde landing in water, this is the usual case. For a dropsonde hitting 
the earth, or with upsondes, the raw data can contain observations that should not be 
included in the processed sounding. The user must then manually specify the end of the 
drop by setting the end of drop time on the Main tab. It is critical that the end of drop be 
correctly set for dropsonde soundings 
The Raw data table and the XY graph are useful for determining the end time. Scroll to 
the bottom of the raw data to view the values of individual data points. On the XY graph, 
enable the raw data trace, and use the mouse to zoom in the area of the sounding end. 
Data point markers and grids can be enabled with buttons above the graph. 

The QC tabular display will only show data points that are within the end 
of data time period. 

Dropsonde                                                                                                                                      
heights and the surface 
For dropsonde soundings, the height calculations are the trickiest part of the Aspen 
analysis. If the drop terminated cleanly at a known altitude, upward integration of the 
heights is straightforward. Upward integration is impossible, however, if the dropsonde 
termination altitude is unknown. This can occur if the drop did not make it all of the way 
to the surface, or if it the termination point on land had an unknown altitude (which is 
almost always the case).  

In the latter situations, the sounding heights can be computed by downward integration 
from the launch altitude. Note that this suitable only if the launch altitude is known with 
accuracy. Usually the launch altitude is provided by the aircraft data system, and it is 
critical to determine the accuracy of this altitude. If altitude is provided by a radar 
altimeter over the ocean, it is probably acceptable. If it is provided by a pressure-based 
altimeter, at some time or distance since the altimeter setting was applied, the aircraft-
provided altitude is probably not acceptable. 
The Main tab has several items that relate to the height calculations. In the box labeled 
“Height Overrides” there are check buttons that have the following effects: 

• Hit Surface – Check this check box if the dropsonde hit the surface. The heights 
will be integrated up from the surface altitude. 
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• Unknown Surface Altitude – Check this box if the surface altitude is unknown, 
such as when a dropsonde has terminated on land. The heights will be integrated 
down from the launch altitude. 

• Set Heights Unknown – Check this box if you feel the heights are not sufficiently 
accurate, no matter which way they are calculated. The heights will not be 
calculated or used in latter processing. 

At the lower right of the Main tab is a box displaying the results of the upward and 
downward height integrations. This is shown for diagnostic purposes. If downward 
integration leads to a launch altitude close to the surface altitude and, likewise, the 
upward integration is close to the launch altitude, then there is confidence in the launch 
altitude. If there are significant discrepancies, the launch altitude is probably incorrect. 
Additionally, differences in the diagnostics can signify a large systematic error in the 
variables used in the height integration, i.e. pressure, temperature or humidity. 
If the surface altitude can be determined for a launch which terminated on land, this value 
can be entered into the surface altitude box, so that the upward integration can be 
computed. 

The final item affecting the height calculation is the Launch Altitude entry in the Launch 
Parameters box in the upper left corner of the Main tab. If another source of the launch 
altitude is available, it may be entered here in order to override the aircraft supplied 
value. The Clear button can be used to remove the override.   

It should be pointed out that the heights are mainly relevant to the coding of the WMO 
messages, where they are used to report the altitudes of standard pressure surfaces. Even 
if the heights are unusable, the WMO message will still contain a very accurate report of 
the sounding based on pressure. The upshot is to set heights to missing when in doubt, 
rather than report erroneous values.  

Launch parameters 
The launch parameters are the surface or aircraft flight level observation made at the time 
of launch. They become either the bottom or top point in the sounding, depending on the 
sounding direction. The QC procedures assume that these launch observations are 
accurate, so they will not be changed. If the launch observations do need to be modified, 
the Launch Parameters box in the upper left corner of the Main Tab has entries that allow 
the user to override them. Enter the new values into the boxes. Use the Clear button to 
revert to the original values. Be sure to hit “Recompute”. 
 

Setting the QC parameters 
The QC parameters, which control the operation of the various QC algorithms, can be 
modified by the user. However, only experienced users who understand the effects of the 
parameters should do this. See the Quality Control Procedures section for a complete 
description.  
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The QC parameters are organized in named sets, with one of them designated as the 
currently active set. The parameters in the active set are the ones used for succeeding 
analyses by Aspen. The active set name is displayed on the right side of the status bar at 
the bottom of the Aspen application window. It is visible for every Aspen tab: 
 

 
The initial installation of Aspen provides a configuration set named “dropsonde”, and 
designates it as active. These parameters are generally useful for dropsonde soundings in 
a tropical environment. If analyzing dropsonde soundings in different environments, as 
well as upsonde soundings, you will almost always need to create a new configuration set 
and adjust its QC parameters appropriately. 

See the Configuration section for directions on setting the active set, maintaining 
configuration sets. 

 
The user should be in the habit of always checking the status bar to verify 
that the correct configuration set is designated as active. 
 
To change the choice of active configuration set, close all sounding files 
within Aspen. The file menu will now have a “Configuration…” entry that 
allows access to the configuration editor. 
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Tab Displays 

Sounding Identifier 
Each tab displays an identifier that describes the sounding. The details are extracted from 
various fields within the raw data file. For graphical displays, this information is printed 
as text on the graph. For other tabs, a yellow bar at the top of the tab contains the 
identification (see figure below). 

Main Tab 

 
 

The Main tab is used to specify certain characteristics of the sounding, and to override the 
launch point observations. Entering a value into the appropriate box specifies the 
override. To remove the override, press the associated Clear button. 
Directions for using the height-related controls is discussed in the Post-Processing 
Adjustments section. 
Be sure to press “RECOMPUTE” after changing items on the Main tab. 
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Raw and QC Tabs 
 

 

 

These two tabs each provide a table of data values. The data is listed in time order. The 
scrollbar on the right side is used to scroll up and down within the table. Notice that the 
pressure of the current scroll position is displayed as the scrollbar is moved. 
The Print and Print Preview commands on the File menu are available for the Raw and 
QC tabs. The preview can be used to determine on which pages a particular range of data 
points falls. The Print command is used to print either the whole table or selected pages. 
The complete table for a sounding will range from 8 pages (drops from 700 mb) to 
upwards of 50 pages (upsondes to <100 mb). 

The Save command allows the data to be saved in the NCAR CLASS or netCDF formats. 
The CLASS format produces an ASCII text file that can easily be imported into 
spreadsheets. 

The launch observations are shown as the first line in the Raw and QC 
data displays. They will not be modified by the QC processing, but 
override values can be specified by the user. 
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XY Graph Tab 
 

 
 

This tab provides numerous options for graphical display of the data. The buttons above 
the graph select which data products and parameters are displayed. The buttons also 
select the choice of vertical axis. The main options on the XY Graph tab are as follows: 

 
Time – Pres – Alt.  These buttons select the parameter displayed along the vertical 
axis. When the tab is first selected, time is chosen as the vertical axis, with only the 
QC data plotted. This leads to the “cleanest” display, since time uniformly increases 
in both the raw and QC data. When the raw data is displayed using the pressure or 
altitude axis, the display may be confusing due to noise in the raw pressure reading.  

 
Zoom - UnZm.  To magnify (zoom) an area of the plot, left-click and drag to draw a 
rectangle around the area of interest. Release the left mouse button to zoom into the 
defined area. The UnZm button restores the graph to the full area display. 
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If the plot is zoomed into a particular area, and then the plot data type is 
changed, or a different vertical axis is selected, the plot area may go 
blank. This is because the zoom area is now in the wrong region for the 
new plot type. Hit the UnZm button to restore the plot to its full region. 
 

Max.  The Max button can be pressed in order to expand the plot to the full screen of 
the monitor. Press the Esc key to bring the monitor back to the normal configuration. 
 

QC – Raw. The QC and Raw buttons select the dataset(s) to be displayed in the 
graph. The two datasets can be displayed simultaneously. Conversely, if neither 
button is selected, no data will be displayed. 
  

Levels.  Pressing the Levels buttons causes the computed levels to be overlaid on the 
graph. Moving the mouse pointer over a level symbol will cause the level type to be 
displayed. Standard levels are displayed as triangles, and other levels are displayed as 
circles. 

Different levels types contain different sets of parameters. For instance, 
the standard levels report temperature, moisture, winds and altitude. On 
the T-RH plot, the standard levels will appear for any vertical axis choice. 
If the axis is set to altitude, however, the significant levels will not be 
shown here, since they are not reporting altitude. Also, if a particular field 
is missing from a level, it will not be overlaid on a trace. For instance, if a 
standard level does not have a temperature data value, it will not appear 
on the temperature trace. 

 
Grids – MarkPts. Grid overlays may be selected from the drop-down list above the 
graph. Marking of the data points can be toggled on and off using the MarkPts push 
button. 

  
The four buttons on the far right select the parameters to be plotted along the horizontal 
axis: 

T – RH.  Selects temperature and relative humidity. 

Speed - Dir.  Selects wind speed and direction. 
Sats – Dz.   Selects number of satellites and ascent speed. 

Pres - Alt.   Selects pressure and altitude.  
The Save button on the far right is used to save the graphic image as a PNG or JPEG file. 
PNG provides better compression and much higher quality graphics presentation for the 
line drawings of Aspen, and is the preferred file format. The pixel dimensions of the 
saved graphic file can be specified in the configuration options. 
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Other plotting options are available by holding down the right mouse button over the plot.  

 

Skew-T Tab 

 
 

A standard skew-T log-P plot is accessed in the Skew-T tab. Zooming, maximizing, 
printing and saving of the plot are available in the same manner as for the XY Graph. The 
right mouse button brings up the same menu of plot options as well. 

Meteorologists  are accustomed to seeing a particular aspect ratio on skew-T plots and 
thus a consistent shape of the various isopleths. To maintain the correct aspect ratio when 
zooming, choose a zoom box whose lower left and upper right corners share a common 
temperature, i.e. they share a common diagonal. An example of a correct zooming 
rectangle is superimposed on the figure above. 
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Levels Tab 

 
 

The Levels tab displays the computed levels, which have been derived from the QC data 
set. The surface and standard levels are highlighted in blue. These are the levels that are 
coded in parts A and C of the WMO message. The levels data can be previewed and 
printed from the File menu. 

The levels listing may be sorted by any of the variables by clicking on the desired column 
heading. Clicking a second time in the same heading reverses the order of the sorting. It 
is typical to sort either by time or pressure, both of which will give similar results. 
In certain cases the Aspen operator may wish to prevent particular levels from being 
coded in the WMO message. Clicking on a level in the Levels Tab will mark a level so 
that it is not coded. Excluded levels are marked with a red background. Click again on the 
level to toggle its status back for normal coding.  Clicking on the temperature, RH, speed, 
direction or altitude fields will select that individual field and prevent it from being coded 
in the WMO message. Clicking on any other field (the columns to the left of these) will 
disable the whole level.  

Not all variables are recorded for each level. This is because each level 
type is used to report only specific variable in the coded message. If a 
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variable is not reported for a given level type, it is not calculated for that 
level. 

 
 

 

WMO Tab 

 
 

The WMO tab displays the WMO message, which has been coded from the levels infor-
mation. It can be previewed and printed from the File menu, and also saved as a text file 
using the Save and Print buttons.  
The WMO message can be emailed from within Aspen by pressing the Email button on 
this tab. The email recipient is specified by the “TempEmailAddress” configuration 
parameter. When the Email button is pressed, the default Windows mail client (e.g. 
Outlook or Outlook Express) is started, and the user is presented with an email editing 
window.  If the message is being mailed to an automatic processing system, such as the 
NWS email GTS ingest gateway, then the mail client should be configured to send in 
plain text format, and to no wrap the text lines. Group or alias entries can also be made in 
the client address book (e.g. “GTS”) to serve as the message recipient address. 
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The format for the WMO message is very exacting, and there may be times when Aspen 
does not get the coding quite right. The buttons at the top left of the WMO tab allow the 
user to modify the WMO message if necessary. Use the mouse to select the code group to 
be edited, and press the appropriate editing button.  

Some code groups, such as the abbreviated header, the 61616 group, and 
the 62626 group contain more than the nominal 5 characters. To select 
these groups for editing, you must click on the left end of the code group. 

There are a number of administrative entries in the WMO message that are not derived 
from the levels data. These are items such as the abbreviated header, and information in 
the 61616 and 62626 groups. This information is managed on the Comm tab. When a 
field is changed on the Comm tab, the WMO message is adjusted accordingly. 

If the sounding analysis is recomputed (from the Main tab), a new WMO 
message will be coded, and any edits made previously will be lost. 

 

 

Comm Tab 
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The Comm tab is used to enter the administrative information that is coded in the WMO 
message. It also has controls for transmitting the WMO message via an attached interface 
on the USAFR WC130 aircraft. The field names should be self-explanatory. 
Press the “Send TEMPDROP message” button to transmit the WMO message. A 
message box will pop up to indicate that the transmission is in progress. 

Most of the data entry fields on the Comm tab are saved as soon as they 
are entered, and used as the defaults for the next sounding that is 
processed. Be sure to verify that the fields are correct before saving or 
transmitting the message.  
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Menu Commands 

The menu commands will be familiar to anyone who has previously used Windows-based 
programs. Only the Tools Menu contains commands unique to Aspen. 

File Menu 
The File menu contains command choices that are generally applicable to all tabs within 
Aspen. There are cases when a command cannot be used with a particular tab. For 
instance, when the Main tab is selected, the File Save command is not enabled, since 
there is no data product associated with this tab. The following commands are found 
under the File menu: 
Open…  Open a sounding file and begin the processing. 

Close  Close the sounding. 
Configuration. Open the configuration editor (available only when no soundings are open. 

Save…  Save data products associated with the tab. 
Print…  Print the tab. The output print format will depend on the tab type. 

Print Preview Preview the print output. 
Print Setup… Configure the printer. 

At the bottom of the File menu is a list of the most recently analyzed files. Sometimes it 
is convenient to go here to reopen a sounding that you have recently examined. 

See the “Configuration” section for an explanation of the configuration management 
procedures. 

Tools Menu 
The Tools menu provides access to commands associated with the QC parameters, when 
a sounding is open. See the “Configuration” section for their description. 

View Menu 
The display of toolbar and status lines is controlled in the View menu. 

Window Menu 
The Window menu contains a listing of all of the soundings currently being analyzed by 
Aspen. Clicking on the file name will bring that sounding to the front of the display.  

Toolbar 
The Toolbar provides buttons that can be clicked instead of selecting some of the entries 
found on the drop-down menus. As with the File menu, the buttons that are enabled 
depend upon which tab is currently selected. 



ASPEN USER MANUAL  QUALITY CONTROL PROCEDURES 
 

 
February 2007 18 

Quality Control Procedures 

One of the main purposes of Aspen is to apply quality control algorithms to a sounding. 
These algorithms attempt to systematically detect data points that are likely to be 
incorrect, and remove them from the QC data set. 

The processing begins with a copy of the original (raw) observations. In most cases, all 
parameters are considered separately. The main exception to this is the handling of the 
wind observations. In this case, the wind speed and direction are separated into u and v 
components, and the QC tests are individually applied. However, if one of the two 
components fails a test, then both components as well as the speed and direction are 
removed from the QC data.  

There are other QC tests that depend upon the relationship between two variables; in 
some algorithms, the processing of a given parameter requires input from another 
parameter. For instance, the GPS-measured velocity is used as a discriminator for the 
horizontal wind observations. In another case, the dynamic adjustment procedure requires 
the time constant of the sensor making the measurement. This time constant is a function 
of density and ventilation rate, which are obtained from the pressure and vertical velocity. 

The Algorithms 
The following table lists the QC processing steps, in the order that Aspen applies them. 
Also listed are the sounding direction and variables to which each step is applied. 
Following the table is a more detailed description of each step. 

 
Table 1. QC Processing Steps 

Sounding 
Direction 

Variable Procedure 

Dn Up P T RH Wind 

Note 

1.  Launch parameter 
overrides 

      a 

2.  Copy raw data set to 
QC data set 

       

3.  End of drop override        

4.  Ambient equilibration        

5.  Apply fixed offsets        
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Sounding 
Direction 

Variable Procedure 

Dn Up P T RH Wind 

Note 

6.  Limit Check        

7.  Satellite Check       b 

8.  Buddy Check        

9.  Outlier Check        

10.  Filter Check        

11.  Pressure Smoothing        

12.  Monotonic Pressure 
Check 

       

13.  Temperature Dynamic 
Adjustment 

       

14.  RH Lower Limiting        

15.  Final Smoothing        

16.  RH Lower Limiting        

17.  Pressure Adjustment        

18.  Compute Vertical 
Velocity 

       

19.  Vertical Velocity 
Check 

      b 

20.  Create Surface 
Observation 

       

21.  Winds Dynamic 
Adjustment 

       

22.  Compute Altitude        

23.  Compute Position        
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Sounding 
Direction 

Variable Procedure 

Dn Up P T RH Wind 

Note 

Notes:  a: Launch parameter override for the winds will be available in a future version 
b: GPS based winds only 
c: Dependent upon sonde type 

 

A description of each processing step follows. If the step can be adjusted via a 
configuration parameter, the title for the configuration item is listed, as it appears on the 
Aspen configuration-editing dialog. See the Configuration section for details on 
managing Aspen configurations. 
1. Launch parameter overrides  Dn   Up   P   T   RH 
The user-specified launch parameter overrides, if any, are substituted for the ones given 
in the data file.  

2. Copy raw data set to QC data set  Dn  Up P T RH Wind 
The QC data set is initialized with a copy of the original observation. If the option is 
chosen to discard frames with CRC errors, these frames are not copied to the QC data set, 
except for the very last frame in the original observation (applies only to AVAPS 
dropsonde soundings). 
3. End of drop override   Dn  Up P T RH Wind 
If the user has specified an end of drop time, all data beyond this time is ignored. 
4. Ambient equilibration   Dn    P T RH Wind  
A dropsonde undergoes an extreme change in environment when exiting the aircraft. The 
pressure, temperature and RH sensors require a significant time period to get close to the 
ambient conditions. This equilibration time is calculated to be 7 times the time constant 
of the sensor, and data within this period is discarded.  

The temperature time constant is dependent on the ventilation rate (which is the fall rate), 
and the air density. Right at the dropsonde launch, the pressure sensor is undergoing 
extreme changes, and cannot be used to determine the dropsonde fall rate. For this 
reason, a theoretical fall rate is calculated, which is based on the force balance between 
the parachute drag and the mass of the sonde. This fall rate has been shown to be 
reasonably accurate. The aircraft measured temperature and pressure, or the first 
observed values in the sounding, are used to calculate the density, and the temperature 
time constant at launch is computed using these parameters.  

The ambient equilibration region for pressure is set equal to the temperature region, so 
that pressure and temperature have the same data coverage at the top of the sounding. 

An empirically determined formulation for the RH time constant is used.  
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5. Apply fixed offsets   Dn  Up P T RH  
Fixed offsets can be added to the measurement. Configuration Item: Offset to Add 
6. Limit Check    Dn  Up P T RH Wind 
Absolute bounds checks are used to discard measurements falling outside of hard limits. 
The limits are set at: 
Table 2. Limit Check Bounds 

Parameter Minimum Maximum 

P 1 mb 1200 mb 

T -100 °C 50 °C 

RH 0 % 100 % 

Wind Speed 0 m/s 150 m/s 

Wind Direction 0 360 

 

7. Satellite Check    Dn  Up    Wind 
GPS-derived winds are not reliable if an insufficient number of satellites are used in their 
computation. If the number of satellites falls below a minimum, the associated wind 
observations are discarded. Configuration item: Number of Satellites 
8. Buddy Check    Dn  Up P T RH Wind 
This test uses the data points on either side of an observation to check for consistency, 
and is useful for detecting and removing wild points. Since the neighboring points may 
be separated from the observation by varying time deltas, the buddy check thresholds are 
specified in terms of change per unit time. A point is discarded if it shows a change 
greater than the limit for one neighbor, and a change greater than the limit, but of the 
opposite sign, for the other neighbor. Configuration Item: Buddy Check Slope 
9. Outlier Check    Dn  Up P T RH Wind 
A least-squares linear fit to the data series is calculated. Data points that are greater than a 
specified multiple of the standard deviation from the linear fit are removed from the data 
set. Configuration Item: Outlier Check 
10. Filter Check    Dn  Up P T RH Wind 
A copy of the data series is low pass filtered at a given wavelength. Data points are 
removed if they differ from the filtered series by greater than a specified deviation. 
Configuration Items: QC Filter Wavelength, QC Filter Deviation 
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11. Pressure Smoothing   Dn  Up P  
The smoothing is applied to the pressure data. The pressure needs to be smoothed before 
the pressure monotonic check. If the final smoothing wavelength is set to 0, this is not 
applied. A small amount of final smoothing should almost always be applied to pressure, 
so that reverse trends in pressure caused by noise will not cause a data point to be 
discarded. Configuration Item: Final Smoothing 
12. Monotonic Pressure Check  Dn  Up P 
The pressure trace must change monotonically in order for pressure-based searching to be 
performed. The pressure time series is scanned; when a point is found which follows an 
incorrect trend (i.e. decreasing for a dropsonde, increasing otherwise), it is removed from 
the series. 
13. Temperature Dynamic Adjustment Dn    T  
The temperature is adjusted for the time lag related to the sensor time constant. The time 
constant is a function of the sonde ascent rate and the density. An empirically determined 
relation for the sensor time constant, as a function of pressure and ascent rate, is used.  
The series is first smoothed using the temperature dynamic correction smoothing 
wavelength. This smoothed series is used to compute a time tendency for each data point. 
Each observation is then adjusted by adding to it the product of the time constant and 
tendency. Configuration items: Dynamic Correction On-Off and Dynamic Correction 
Wavelength 

14. RH Lower Limiting   Dn  Up   RH  
RH values less than 0.2% are set to 0.2%. 

15. Final Smoothing    Dn  Up  T RH Wind 
The series are smoothed using the final smoothing wavelength. If the final smoothing 
wavelength is set to 0, this is not applied. Configuration Item: Final Smoothing 
16. RH Lower Limiting   Dn  Up   RH  
RH values less than 0.2% are set to 0.2%. 
17. Pressure Adjustment   Dn   P  
If a surface pressure is specified on the main tab, it is proportionally applied to the 
pressure profile as a function of time. Thus the bottom pressure value becomes the 
specified pressure, and the launch pressure is unchanged, with a proportional adjustment 
applied between these points. 

18. Compute Vertical Velocity  Dn  Up P  
The pressure series is first smoothed using the final pressure-smoothing wavelength. The 
time tendency of the pressure is then computed at each data point. The time-differentiated 
hydrostatic equation is then used to compute the vertical velocity.  
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19. Vertical Velocity Check   Dn  Up    Wind 
The GPS-measured fall velocity is a good discriminator for the quality of the GPS-
derived horizontal wind. If the difference between the hydrostatically determined fall 
velocity and the GPS-measured velocity is greater than the specified limit, the horizontal 
wind point is discarded. Configuration item: Vertical Velocity Threshold 
20. Create Surface Observation  Dn   P T RH  
In order to achieve as accurate a surface pressure reading as possible, a procedure is 
applied which attempts to account for the distance the dropsonde fell to the surface after 
the last data point was reported. Empirical estimates of this distance are used to 
extrapolate the last surface pressure measurement to the surface. The last temperature and 
RH are simply duplicated for the surface measurement, since the distance is generally on 
the order of 5 meters. These fabricated measurements of pressure, temperature and RH 
are appended to the data series.  
21. Winds Dynamic Adjustment  Dn  Up    Wind 
Each wind component is adjusted with the formula: unew = uobs - (du/dt)*(dz/dt)/g. The 
wind component series is first smoothed, using the winds dynamic correction smoothing 
wavelength for the component. This smoothed series is used to compute a time tendency 
for each data point. The observation is then adjusted according to the formula, using the 
previously calculated vertical velocity for dz/dt. Configuration items: Dynamic 
Adjustment On-Off and Dynamic Correction Wavelength 
22. Compute Altitude    Dn  Up  
The hydrostatic equation is integrated from the surface upwards. For dropsondes, the 
same computation may be made from the launch altitude downward. See the Post-
Processing Adjustment section for a description of dropsonde height computations. 

The downward height integration requires both a starting altitude and a starting pressure. 
If the pressure at launch time for a dropsonde is not available (a common situation on 
many aircraft), the first raw pressure point from the dropsonde is used as the launch 
pressure, but only for the purpose of height computation. This unwarranted assumption 
can lead to significant height errors if the raw sonde pressure data is late or inaccurate. 
23. Compute Position    Dn  Up  
The horizontal winds are used to integrate the sonde location from the initial launch 
position. If a time gap of greater than maximum position integration interval (a 
configuration parameter) occurs in the wind measurements, the integration terminates.  
The position integration requires an initial position to start the integration. Similarly, an 
initial wind speed and direction at the launch point are used in the integration. If these are 
not available, Aspen will use the first Q/C wind speed and direction as the launch point 
value. This unjustified assumption thus assumes a constant wind profile at launch, in the 
absence of a wind measurement at the launch point. Configuration Item: Position 
Interpolation 
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Guidelines for Adjusting QC Parameters 
The supplied default values for the Aspen Q/C parameters in general produce excellent 
results. However, there may be times when a group of soundings have peculiar error 
characteristics, and the Q/C paramaters need to be modified in order to produce better 
discrimnation against outliers. Some tips for adjusting the configuration parameters are 
given here. The user should carefully read and understand the descriptions of the Q/C 
algorithms given in the preceeding section; this will provide the best guidance on 
modifying the Q/C parameters to match the error characteristics of the sounding data. 

• Toggle the display of raw data off and on in order to see which data points are 
being rejected by the algorithms. Toggle the “mark points” option, and use the 
zoom and pan capabilities freely to investigate the effectiveness of the procedures. 
Stay zoomed in on a region when modifying configuration parameters, and use 
the “!” (recompute) button to reprocess the sounding, so that the new results are 
displayed immediately in the zoomed region. 

• If the sounding system does not report the number of GPS satelittes used in the 
winds calculation, set the GPS satellite threshold to 0, so that winds are not 
discarded due to a lack of satellites. 

• The most frequently adjusted parameters are the the QC Filter Wavelength and 
the QC Filter Deviation, which are used in the filter check and are applied 
together. In this algorithm, a smoothed curve is calculated from the data series. If 
the filter wavelength is small, the curve will closely follow the data; if large the 
curve will be a very smooth representation of the data. The deviation is the 
amount that a data point is allowed to deviate from the smoothed curve. If the 
difference between the curve and the raw data point is larger than the deviation, 
the data point is discarded. The interplay between the amount of smoothing and 
the allowed deviation allow for wide latitiude in tuning the filter check algorithm. 

• The dynamic adjustments for temperature and wind speed can significantly 
increase the variance of the data series. If the Q/C results appear noiser than the 
raw data, it will be due to the dynamic adjustments. Use of the dynamic 
adjustments is the perogative of the user, and can be deactivated in the 
configuration. Note that the tendency of the series, used in the adjustment, is 
calculated from a smoothed version of the data. The dynamic correction 
smoothing wavelength is used for the smoothing value during the dynamic 
adjustment procedure. If a very small smoothing wavelength is specified, the 
variance increase in the Q/C data can become significant. 
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Configuration 

Aspen is very flexible and can produce a large variety of output products. It will analyze 
data from a number of different sounding systems. In order to tailor it for differing 
applications, Aspen provides a configuration system. This same system is used to 
configure Aspen, BatchAspen and AspenQC, and the configuration information is shared 
between each of these programs. 

Configuration Items: At the heart of the configuration system is the configuration item, 
which matches a keyword with a current value, and a default value. The keyword 
identifies a particular characteristic to be used during the next Aspen analysis; e.g. the 
smoothing wavelength to be applied the pressure field, or the mass of the dropsonde. 

Configuration sets: A family of configuration items is collected in a configuration set. 
Configuration sets are assigned names, and a named set is chosen as the currently active 
one, to be used the next time that Aspen is run. In this way, users can create configuration 
sets that are tailored to a particular instrument, environment, or field program, and switch 
between them as needed. 
The Active Set: At any time, one of the named configuration sets is designated as the 
active set. This means that any further processing with Aspen or BatchAspen will use the 
configuration items from the active set. It is critical that the user verify that the 
correct set has been designated as active when processing soundings. 
A user interface is provided within Aspen and BatchAspen for manipulating the Aspen 
configuration. This is divided into two activities. The first is the management of the 
configuration sets: creating, deleting and activating a set. The second is modification of 
the configuration items within a selected set. 
Note that within Aspen, the management of the configuration sets can only be initiated 
from the File menu, when no soundings are currently open. Configuration items for any 
named set may be modified at this time also. However, configuration items for the 
currently active set may also be modified when soundings are open within Aspen. 
aspen.xml: The configuration information is stored in XML1 format, in a file named 
aspen.xml. A “Document Type Definition file”, aspen.dtd, accompanies aspen.xml, and 
must be located in the same directory. See the Appendix A: Configuration Parameters, 
for a description of aspen.xml. 
The location of these files depends upon the version of Windows, as well as the 
ASPENCONFIG environment variable. When Aspen first runs, it checks to see if 
ASPENCONFIG is set. If it is, Aspen then checks for the existence of the configuration 

                                                
1 XML: Extensible Markup Language; this is a widely used standard for defining structured data, and is 
used extensively in Web applications. 
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files in that directory. If the files are not found, Aspen offers to copy default 
configuration files to that directory. 
If ASPENCONFIG is not set, Aspen will assume directories for the configuration files, 
according to the following: 

• For Windows 98 systems: The directory where Aspen is installed  
• For Windows NT/2000/XP systems: C:\Documents and Settings\<user 

name>\Application Data\Aspen\. This scheme allows individual users to maintain 
private versions of the configuration files. 

Configuration Set Management 
Management of the configuration sets is available through the File->Configure… menu 
within Aspen and BatchAspen. Choosing this item will cause a configuration set 
management dialog to open, from which configuration sets may be activated, deleted, 
created  and edited: 
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The selection drop down box at the top of the dialog is used to select the named 
configuration set that all other operations will reference. The selected set can be 
activated, deleted, or edited using other buttons in the dialog. To create a new 
configuration set, select an existing set to be used a source set, enter a name in the box, 
and hit the Create button. 
When all configuration editing actions are finished, hit the Ok button to save them, or the 
Cancel button to discard the changes. 
The actual configuration items for the selected configuration set can be edited by hitting 
the Edit button. This will bring up a dialog from which the quality control parameters and 
other options can be modified. See the “Changing the QC Parameters” section (below) 
for details on modifying the configuration items from this dialog. 
Hitting the Restore Defaults button will restore the entire set of configuration items for 
the selected set, restoring them to their default values.  
The Sample Configuration Set: There is a special configuration set, named sample, 
provided with Aspen. This set cannot be activated, deleted or edited. It is available as a 
default set that can be used as the source when creating a new configuration set. 

Remember that within Aspen, the configuration editor is only available 
(from the File->Cofigure… menu) when no soundings are open. When 
soundings are open in Aspen, the options for the currently active 
configuration set can be edited from the Tools->Options menu. 

Changing the QC Parameters 
In order to configure Aspen to match your particular requirements, the configuration 
items (i.e. parameters) within a configuration set must be properly specified. This can be 
initiated from either the configuration management menu (File->Configure…->Edit 
Options) when no files are open, or from the options menu (Tools->Options…). A tabbed 
property sheet will open, containing two tabs. The “Quality Control Parameters” tab is 
used to configure quality control parameters: 
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The quality control parameters are used to adjust the various quality control algorithms, 
and are described in the “Quality Control Procedures” section. 

Other Options 
The “Other Options” tab provides further options for the processing of sounding data: 
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QC Processing.  In normal usage, this feature should always be enabled. If it is 
turned off, Aspen will only display the raw sounding data. This may be useful if you 
want a quick look at a large data set without waiting for processing. 
Levels – WMO message.  These two features should always be enabled if WMO 
messages are the ultimate data product (e.g. weather reconnaissance). For all other 
soundings, these features may be turned off. 
Levels Thresholds. These five parameters set the thresholds used in the 
determination of the GDL levels for the designated measurement. They should be 
modified with caution, since this would result in a deviation from the specifications of 
the FMH-3. 
Tropopause Level Detection: Lapse Rate Smoothing Wavelength. This is the 
wavelength of the smoother that will be applied to the temperature data before the 
automatic determination of tropopause levels is made. A tropopause is identified by 
the derivative of the temperature lapse rate, and so a high variance in temperature can 
lead to the creation of unrealistic tropopause levels. 

WMO Message Type.   Choose the type of TEMP message to be generated for an 
upsonde sounding. 
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Block Station Number and Call Sign.   These are identifiers that are required either 
for the TEMP, TEMPSHIP, or TEMPMOBILE messages. 
Upsonde Abbreviated Header. The WMO abbreviated header for upsonde WMO 
messages. (Note that dropsonde abbreviated headers are specified on the Comm tab). 

Upsonde ICAO Code. ICAO code for upsonde abbreviated headers. (Note that 
dropsonde ICAO codes are specified on the Comm tab). 

Email address for TEMP. Address to receive an emailed WMO message. 
Append NNNN Terminator. If checked, append NNNN to the WMO message when 
it is saved or emailed. Some communications systems, such as the GTS, require this 
terminator. 

Disable Abbreviated Header.  If checked, the abbreviated header will not be 
generated for the WMO message. This is useful in the common situation where 
another system generates the abbreviated header. 
Dropsonde Mass and Parachute Area.   The dropsonde mass and parachute area are 
required in order to estimate the initial fall speed of the dropsonde, after launch from 
the aircraft. The values differ only from the defaults in special cases where a custom 
parachute or modified sonde are deployed. 
Dropsonde Hit Surface. This box is checked if the dropsonde was believed to have 
hit the surface. This causes the sounding altitudes to be integrated from the surface 
altitude upwards; otherwise they will be integrated from the flight level altitude (if 
available) downward. If checked it also allows the computation of an extrapolated 
surface data point. 

Surface Altitude Unknown. Check this box if the dropsonde was believed to have 
hit the surface, but the surface altitude is unknown, as in a dropsonde landing on the 
earth. It causes the height integration to be performed from flight level down. 
Discard frames with CRC errors. If this box is checked, data frames that are 
marked as having a CRC error are discarded. This only applies to AVAPS dropsonde 
soundings. 

RH Channel. The AVAPS/Dropsonde based systems use a radiosonde that carries 
dual relative humidity sensors. The firmware in the sonde chooses the humidity value 
from one of them, and the selected channel is reported in the main RH field of the 
“D” file. The original values for both sensors are reported in additional columns in 
the file. The user can elect to use the sonde chosen value (AVAPS selected), or either 
of the original sensor values (RH1 or RH2). 

Set Heights Missing. Check this box to cause the height computations to be skipped, 
in cases where the operator does not trust the data to provide for accurate height 
integration. 
Open File Chooser on Startup.   If this box is checked, a File Chooser dialog will 
open as soon as aspen is started. Otherwise, the File menu can be accessed in order to 
select a file to process. 
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Position Interpolation Interval.   Set the maximum time interval over which the 
winds can be interpolated for the position integration calculation. If the gap in winds 
is greater than this interval, the winds will not be interpolated and the position 
integration will stop. 

Plot dimensions, pixels. Specify the X and Y dimensions, in pixels, for graphics 
output files. 

Default plot file. Choose either PNG or JPG as the default choice for the output 
graphics file format. The user can also choose the file type at save time. PNG is the 
recommended format. 
Generate Q/C diagnostics file. Select this to cause a file with Q/C diagnostic 
information to be created. The file name will begin with ‘AspenDebug’ and have a .txt 
extension. It will be created either in the directory where the Aspen program is 
installed, or the directory where the first data file is located. Be sure to disable this 
option when finished, otherwise diagnostic files will be created every time Aspen is 
run. 

Saving Changes and Restoring Defaults 
When the user closes a sounding in which the QC parameters have been changed, a 
dialog box asks if these parameters should be saved as the processing defaults. All 
soundings opened after this time will be processed using these options. The Tools menu 
provides a command, ToolsRestore Defaults, which can be used to restore the options 
to initial system defaults. Thus the customized parameters will revert to the initial 
installation defaults.  

The user may also revert the QC parameters to the initial installation defaults before 
opening any soundings. This is done via the File Configure…Restore Defaults button 
(available only when no soundings have been opened). 
 

When in doubt about the proper values of the QC parameters, restore the 
defaults. 
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Corrupted Configurations 
As mentioned above, the configuration information is stored in the aspen.xml file. If the 
configuration file becomes corrupted, Aspen will not be able to run, and the file will need 
to be repaired or restored. 

The file “AspenOriginal.xml” is provided as a copy of the orginally distributed 
configuration file, and is located in the Aspen installation directory (typically 
“C:/Program Files/ NCAR/Aspen”. In the worst case, this file can simply be copied over 
aspen.xml (note that the file name case is significant). This will restore Aspen to the 
default configuration parameters, but all changes or additions that have been made to the 
configuration will be lost. 

If the aspen.xml file is only slightly corrupted, it may be possible to correct the error with 
a text editor. A simple way to locate a syntax error is to open aspen.xml in Internet 
Explorer, which provides structured viewing of XML files. Internet Explorer will indicate 
lines that do not parse correctly, and then a standard text editor may be used to fix minor 
problems. 
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BatchAspen 

BatchAspen is a separate application that is used to apply the Aspen Q/C procedures to a 
collection of sounding files. The user selects the data products to be created. The program 
then iterates over the list of files, placing the results in a specified destination directory. 

BatchAspen shares an exact copy of the Q/C processing algorithms that are used by 
Aspen, so that identical results for both programs can be guaranteed. 

Starting BatchAspen and Selecting Files 

Start the application by clicking on the BatchAspen icon . A single screen will be 
presented. The screen is roughly divided into left and right sections, with control buttons 
in between. The left side is used to select the files to be processed. The right side 
specifies the output file destination and the processing list: 
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On the left side, there are two independent directory browsers, either of which can be 
used to navigate into directories containing input files. The files in the selected directory 
are shown in the file selector in the lower left. The display of file types can be restricted 
using the “File Filter” in the center edit box. 

Individual files can be selected, using the standard Explorer left-click, shift-left-click, and 
ctrl-left-click mouse selection commands. Once the desired files are chosen, press the 
“Add->” button to add them to the processing list on the right side of the screen. Pressing 
“Add All->” will cause all of the displayed files to be added to the processing list. 

Selected files can also be dragged from the file selector and dropped into the processing 
list. 

 Files from multiple directories can be collected in a single processing list. 
However, all output files will be created in a single directory. 

Files may be removed from the processing list by selecting them in the processing list, 
and pressing the “<-Remove” button, or press “<-Remove All” in order to empty the list 
completely. 
To select the output directory, hit the “Browse” button above the processing list. A folder 
browser will pop up; use it to select the folder for the output files.  
 

 
 

Create a new folder by pressing the “new folder”  button. 
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Q/C Processing 
The desired output products are chosen using the toggles: 

  
An output file of each selected type will be created for each input file.  

To begin the processing, hit the  button. BatchAspen will start processing 
each file, starting at the beginning of the list. A status indicator will appear next to each 
file, with a yellow star denoting the file currently being processed. A check mark 
indicates that the file was successfully processed; an unhappy face denotes a file that 
could not be processed.  

 
During the processing of each file, the status box at the top of BatchAspen provides a 
running display of the Q/C processing steps. 
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When processing is underway, the “Process” button changes to . To stop the 
processing before the end of the list has been reached, press Abort. BatchAspen will stop 
when the processing of the current file has completed2. 

Q/C Parameters 
BatchAspen uses the same configuration scheme as Aspen, which is documented fully in 
the “Configuration” section. As with Aspen, activating the File->Configure… menu item 
will display the configuration management interface.  

The configuration set that is designated as active is used by both Aspen 
and BatchAspen. 

 

 

                                                
2 This may take up to several minutes on a slow machine. 
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AspenQC 

AspenQC is a version of Aspen that performs the Q/C and message coding functions, but 
does not provide a graphical user interface. Therefore, it can be run from shell scripts or 
the command line, to process a sounding data file in a standalone mode. The same Q/C 
and coding algorithms used in Aspen are incorporated into AspenQC. 
A Windows executable file, AspenQC.exe, is provided in the Aspen Windows 
distribution. AspenQC can be compiled and run under Linux. Contact NCAR in order to 
obtain the source code for Linux.  

AspenQC uses the same XML configuration file as Aspen, located in the ASPENHOME 
directory. 

Switches 
Command line switches control the processing and output products from AspenQC: 
usage: AspenQC [-i|--input <sounding file>] 

               [-e|--csv [<output csv file>]] 

               [-c|--class [<output class file>]] 

               [-w|--wmo [<output wmo file>]] 

               [-n|--netcdf <output netcdf file>] 

               [-v|--verbose] 

               [-s|config <config set name>] 

               [-a|--csvattributes] [-h|--help] 

• i – the name of the input data file. AspenQC will automatically determine the file 
type, and as with Aspen, will make assumptions about the type of souding, 
dependent on the file format. AVAPS, CLASS, GLASS, MCASS and CSV 
format files can be processed. If this parameter is missing, the data are read from 
standard input. 

• e – Generate a CSV format output file (“-e” is meant to indicate Excel, since CSV 
files are the best method for transferring data between AspenQC and Excel). 

• c – Generate a CLASS format output file. 
 

• n – Generate a netCDF format output file. 
 

• w – Generate a WMO message. 
 

• v – Print (verbose) status messages as the processing proceeds. 
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• s – Specify a config set name to override the one selected by the <active> tag in 
the XML configuration file. 

• e – If a CSV file is being created, print the configuration attributes at the 
beginning of the file. 
 Note that these will not be interpreted or used when a CSV file is used as input to 
AspenQC. 

• h  – Print out the usage statement. 
 

The output format specifiers (-e, -c, -w and –n) can take an optional file name, to which 
the data will be written. If not provided, the data will be written to the standard output. 

An example of an AspenQC usage would be: 
AspenQC –i classData.dat –a –e classData.csv 
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Input File Types 

Aspen can process sounding data that is provided in the following file formats: 

• NCAR AVAPS GPS Dropsonde “D” files 
• NCAR GLASS Upsonde files  

• NCAR GAUS Upsonde files  
• NCAR CLASS Upsonde files 

• NCAR MCASS Upsonde files 
• “Comma Separated Values” (CSV) (MS Excel compatible)3 

Warning: Aspen automatically detects the format of the file that it opens, 
and assumes that the sounding contained is from the associated 
instrument. This can lead to ambiguities, if Aspen is used to process a file 
that it has written. For instance, if dropsonde data are saved by Aspen in 
“CLASS” format, and then this file is used as input to Aspen, the program 
will assume that the data are from an upsonde sounding, rather than a 
dropsonde. This can lead to erroneous results within Aspen, since the 
characteristics of the sounding system affect the processing procedures. 

 
Output files can be produced for data products in the following formats: 
Table 3. Output File Types 

Data Product File Output Formats 

Raw data NetCDF 
CSV 
NCAR CLASS format ASCII text 
NCAR EOL format ASCII text 

QC data NetCDF 
CSV 
NCAR CLASS format ASCII text 
NCAR EOL format ASCII text 

Graphics JPG 
PNG 

                                                
3 See Comma Separated Values (CSV) on page 49 for a more general description of Aspen compatible 
CSV files. 
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Data Product File Output Formats 

(or use Alt-PrtSc for clipboard capture) 

Levels None 

WMO message ASCII text 
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Appendix A: Configuration Parameters 

The Aspen configuration is stored in XML format. There are two files: aspen.xml and 
aspen.dtd. aspen.xml contains the actual configuration values, while aspen.dtd defines the 
syntax of the aspen.xml file. 

Explanation of the structure of XML files is beyond the scope of this manual. However, 
given an existing XML file, it is not difficult to discern the layout of the information4. 
XML elements are delineated by start and end tags, and are nested to create a hierarchical 
data structure. aspen.xml observes the following structure: 
<aspenConfig> 

<active>dropsonde</active> 
<set name="sample"> 

  <option name="SetHtsMissing" type="bool"> 
   <current>false</current> 
   <default>false</default> 

</option> 
. 
. 
. 
<option name="WindSmoothWL" type="numeric"> 

   <current>10.000000</current> 
   <default>10.0</default> 
  </option> 

<option immediate="true" name="IcaoIndex" type="numeric"> 
 

   <current>1.000000</current> 
 

   <default>1</default> 
 

</option> 

 </set> 
<set name="dropsonde"> 
. 
. 
. 

 </set> 
</aspenConfig> 
 

Thus, the Aspen configuration contains one entry (<active>), designating which named 
configuration set is active, followed by one or more named configuration sets (<set>). 

                                                
4 This is particularly easy if the the file is examined with an XML capable browser, such as Internet 
Explorer. 
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Each configuration set contains a list of configuration options (<option>), with the 
current and default values for each option. Each option has a designated type: 

• bool – boolean, with a value of either true or false. 
• numeric – A floating point numeric value. 

• string – A text string.  
An option may also be marked with “immediate=true” to effect an immediate save of the 
option when it is changed. It is useful for some options to be saved immediately after 
they are changed, before closing the sounding in Aspen, so that when the next sounding 
is analyzed, it will immediately use the new version of the option. For instance, if the 
dropsonde operator on the Hurricane Hunter aircraft opens a sounding, and then changes 
the ICAO value for the TEMP message, it is likely that all soundings opened during the 
same run of Aspen should use this value for the ICAO string. An immediate save allows 
the configuration to be updated, without having to close that sounding. 
The following table gives a description of the configuration options. 

The case of the configuration item name is critical. It must be matched 
exactly as shown. 

Element name Type Description 

SetHtsMissing bool Corresponds to the “Set heights missing” 
checkbox on the main tab, which causes 
height computations to be skipped. 

DropsondeHitSfc bool Corresponds to the “Dropsonde Hit Surface” 
checkbox on the main tab, indicationg that 
the dropsonde sounding terminated with 
hitting the surface. 

SfcAltUnknown bool Corresponds to the “Surface Altitude 
Unknown” checkbox on the main tab, which 
when set causes the upward height 
computation to be skipped. 

DiscardBadCrcData bool Set true if frames with CRC errors are to be 
discarded. (AVAPS dropsondes only). 

ReportObservedPos bool If true, the sonde position reported in the 
input file will be used in place of the 
winds integrated position. Lat and Lon from 
the input file will go directly into output 
products and the tabular displays. This can 
be utilized to take advantage of sondes 
which report GPS positions directly. The 
default is false. 

WindSmoothWL numeric Final smoothing wavelength. Set this to 0 to 
disable final smoothing. 
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Element name Type Description 

WindQCWL numeric Filter check smoothing wavelength. 

WindDynCor bool Enable dynamic correction. 

WindDynCorWL numeric The wavelength used when smoothing the wind 
data prior to calculating the derivative 
used in the dynamic correction. 

WindBuddySlope numeric Buddy check slope limit. 

WindQCDev numeric Filter check deviation limit. 

WindOutlier numeric Outlier check number of standard dev. limit. 

WindSats numeric Minimum number of GPS satellites required in 
wind solution. 

WindVVdelta numeric Vertical velocity check limit. 

WindEquilTime Numeric For dropsondes, winds falling within this 
time period from the launch will be 
discarded. 

PresSmoothWL numeric Final smoothing wavelength. Set this to 0 to 
disable final smoothing. 

PresQCWL numeric Filter check smoothing wavelength. 

PresBuddySlope numeric Buddy check slope limit. 

PresQCDev numeric Filter check deviation limit. 

PresOutlier numeric Outlier check number of standard dev. limit. 

PresOffset numeric Offset correction. 

TdryQCWL numeric Filter check smoothing wavelength. 

TdryDynCor bool Enable dynamic correction. 

TdryDynCorWL numeric The wavelength used when smoothing the 
temperature data prior to calculating the 
derivative used in the dynamic correction. 

TdryQCDev numeric Filter check deviation limit. 

TdryOutlier numeric Outlier check number of standard dev. limit. 

TdryOffset numeric Offset correction. 

TdryBuddySlope numeric Buddy check slope limit. 
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Element name Type Description 

TdrySmoothWL numeric Final smoothing wavelength. Set this to 0 to 
disable final smoothing. 

RHSmoothWL numeric Final smoothing wavelength. Set this to 0 to 
disable final smoothing. 

RHQCWL numeric Filter check smoothing wavelength. 

RHBuddySlope numeric Buddy check slope limit. 

RHQCDev numeric Filter check deviation limit. 

RHOutlier numeric Outlier check number of standard dev. limit. 

RHOffset numeric Offset correction. 

TdryLevelDelta numeric Threshold value for GDL determination on 
temperature.  

RHLevelDelta numeric Threshold value for GDL determination on RH.  

WspdLevelDelta numeric Threshold value for GDL determination on 
wind speed. 

Wspd850LevelDelta numeric Threshold value for GDL determination on 
windspeed, below 850 mb. Applies only to 
dropsondes. 

WdirLevelDelta numeric Threshold value for GDL determination on 
wind direction. 

TropSmoothWL numeric The wavelength used for smoothing of the 
temperature time series before calculation 
of tropopause levels. 

DoQC bool True to perform quality control processing. 

DoLevels bool True to calculate levels. 

DoWMO bool True to create the coded message. 

AutoFile bool True to enable of file chooser when aspen 
starts. 

ChuteArea numeric Dropsonde parachute cross section area , cm2. 

 

DropSondeMass numeric Dropsonde mass, grams. 

PosInterpSpan numeric Maximum time span, in seconds, over which 
the position integration will be 
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Element name Type Description 

interpolated. 

CallSign string Immediate, call sign for TEMPSHIP and 
TEMPMOBIL messages. 

BSN string Immediate, Block Station Number for TEMP 
messages. 

TempMsgType numeric Temp message type (0=TEMP, 1=TEMPSHIP, 
2=TEMPMOBIL) 

TempApendNNNN Bool Set true if an NNNN should be appended to 
the TEMP message when it is saved in a file. 
This terminator is required by some 
telecommunication gateways. 

RHchoice numeric AVAPS RH channel selection(0=AVAPS selected, 
1=RH1, 2=RH2) 

ExcludeAbrHdr bool True if the abreviated header should be 
excluded from the TEMPDROP message. 

PlotPixelsX numeric Default plot X dimension in pixels. 

PlotPixelsY numeric Default plot Y dimension in pixels. 

PlotFileFormat numeric Default graphics file output format (0=PNG, 
1=JPG) 

ACtype numeric Immediate, Dropsonde aircraft type (0=C130H, 
1=C130J). Use only for the automated file 
transfer method for Huricane Hunters. 

BaudRateIndex numeric Immediate, serial port baud rate selector 
for Hurricane Hunter C130H aircraft. (0=300, 
1=1200, 2=2400, 3=4800, 4=9600, 5=19200, 
6=38400) 

CommPortIndex numeric Immediate, serial com port selector for 
Hurricane Hunter C130H aircraft. (0=com1, 
1=com2, … 7=com8) 

ACagency string Immediate, agency designator in the TEMPDROP 
61616 group. 

MissionStorm string Immediate, storm designator in the TEMPDROP 
61616 group. 

MissionId string Immediate, mission id designator in the 
TEMPDROP 61616 group. 

IcaoIndex numeric Immediate, index of ICAO designator (0=user 
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Element name Type Description 

defined, 1=KNHC, 2=KBIX, 3=KISX, 4=KHIK, 
5=KTRR. For TEMPDROP messages. 

AbrHdrOvr string Immediate, User defined overide for the 
abreviated header. For TEMPDROP messages. 

AtcfId String Immediate, the ATCF cyclone or storm system 
identifier. 

OptIcao numeric Immediate, user defined optional ICAO 
identifier. For TEMPDROP messages. 

UpsondeAbrHdr string Immediate, abbreviated header code (e.g. 
UUNA15) for upsonde messages.  

UpsondeICAO string Immediate, ICAO code (e.g. KWBC) for upsonde 
messages. 

TempEmailAddress String Immediate, email address that TEMP messages 
should be sent to. 

DataDir string Directory where input data files are 
located. 

WmoSaveDir string Directory to save WMO messages in. 

QCSaveDir string Directory to save QC data in. 

RawSaveDir string Directory to save raw data in. 

XYPlotSaveDir string Directory to save XY plot graphics in. 

SkewTPlotSaveDir string Directory to save Skew-t plot graphics in. 

BatchSaveDir string For BatchAspen use, defines the diretory 
that output files will be written to. 

BatchSaveRawCLS bool For BatchAspen use, set true to save the raw 
data in a CLASS format file. 

BatchSaveQCCLS bool For BatchAspen use, set true to save the Q/C 
data in a CLASS format file. 

BatchSaveRawCDF bool For BatchAspen use, set true to save the raw 
data in a netCDF format file. 

BatchSaveQCCDF bool For BatchAspen use, set true to save the Q/C 
data in a netCDF format file. 

BatchSaveRawCSV bool For BatchAspen use, set true to save the raw 
data in a CSV format file. 
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Element name Type Description 

BatchSaveQCCSV bool For BatchAspen use, set true to save the Q/C 
data in a CSV format file. 

BatchSaveWMO bool For BatchAspen use, set true to save the WMO 
message in a text file. 

FixedSrcEnabled bool If true, the source data and save 
destination directories will specified by 
FixedSrcDir 

FixedSrcDir string The directory to use as a data source and a 
save destination, if FixedSrcEnabled is set 
to true. 

QcDiagFile Bool If true, create a text file containing 
diagnostic information from the Q/C process. 
Usually not of much use to the typical user. 
The file will be written to either the 
directory where Aspen is installed, or the 
directory that the first data file read is 
located. The file name begins with 
AspenDebug-, is followed by a time stamp and 
then a .txt extension. 

Table 4. Configuration Parameters 
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Appendix B: File formats 

An overview of the output file formats is given here. The file structures are 
sraightforward, and examination of the files will provide most of the documentation on 
their formats.  

Note that the file formats are not complete; i.e one format will contain information that 
another format does not support. Thus, the CSV and netCDF formats can document the 
configuration parameters used in the processing, whereas the CLASS format does not 
support inclusion of this information. 

CLASS Format 
The CLASS file starts with a 15 line header section, followed by a variable number of 
data lines. The data lines are arranged in fixed width columns. A mandatory set of 21 data 
parameters is reported, even though a number of these (specifically the “quality” values) 
are always marked with a missing value indicator. 
The data is reported in the sequence of decreasing pressure, i.e. from the surface upward, 
regardless of the direction of the sounding. 

EOL Format 
The EOL file starts with a 15 line header section, followed by a variable number of data 
lines. The data lines are arranged in fixed width columns. A fixed set of 17 data 
parameters is reported 

The data is reported in the sequence of decreasing pressure, i.e. from the surface upward, 
regardless of the direction of the sounding. 

NetCDF 
Section “Appendix D: netCDF Attributes” contains the attributes listing from an ncdump 
of an Aspen generated netCDF file. Note that for legacy compatibilty reasons, a number 
of unecessary variables are included in the netCDF file. The global attributes contain a 
record of the Q/C processing options. 

Comma Separated Values (CSV) 
The “Comma Separated Value” file format is used for data interchange between Aspen 
and other software. It is a free form structure, with one data record per line, and the fields 
in a record separated by commas. A CSV file can be read directly into Microsoft Excel, 
and the data will be correctly organized in the spreadsheet. 

For input to Aspen, certain conventions must be followed within the CSV file. 
Each line begins with an identifier, followed by one or more fields. The order of the lines 
is generally not important, within the following guidelines: 
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• The first line must be:  
FileFormat,CSV 

• After the first line, the launch time must be provided on lines as follows: 
 
Year,2001 
Month,08 
Day,01 
Hour,17 
Minute,58 
Second,34 

• The launch observation data may be provided in lines labeled with the parameter 
name. 

• To designate a dropsonde sounding, include a line:  
Ascending,"false" 

• A “Fields” line defines the data fields and their order, for the succeeding “Data” 
lines. Aspen output CSV files will contain a fairly large number of fields, e.g.: 
Fields,Time,Pressure,Temperature,RH,Speed,Direction,Latitude, \ 
Longitude,Altitude,Dewpoint,Uwnd,Vwnd,Ascent 

• For an input CVS file to be read properly by Aspen, the following data field 
conventions must be followed: 

Fields Aspen utilization 

time 
pressure 

These are required input data fields. 

rh 
rh1 
rh2 
speed 
direction 
latitude 
longitude 
altitude 
ascent 
sats 
gpsalt 

These data fields will be utilized, if provided. 

others Other data fields will be ignored on input. 

• The “Units” lines documents the units of each data field. Note that the units 
shown here must be adhered to; Aspen will not make units conversions. At least 
the time and pressure fields must be provided: 

Units,sec,mb,deg C,%,m/s,deg,deg,deg,m,deg C,m/s,m/s,m/s 



ASPEN USER MANUAL  APPENDIX B: FILE FORMATS 
 

 
February 2007 51 

• The “Data” lines follow after all of the preceeding records. 

Some other rules apply: 
• Long strings should be enclosed in quotes. 
• Don’t include commas in strings 

• Capitalization is not important. 
• The data series must be ordered in time 

• Time tags less than zero will be ignored 
• Don’t use reserved strings in the first field of a line. 

• “Fields” must come before “Data” 
• Missing data are simply represented by empty fields, i.e. two commas in 

succession, or a trailing comma on the end of a line, indicating that the last field is 
missing. 

The following demonstrates a small CSV file (note that the line breaks are not found in 
the actual file): 
FileFormat,CSV 
Year,2001 
Month,08 
Day,01 
Hour,17 
Minute,58 
Second,34 
Pressure,57.6,"units=mb" 
Temperature,-59.9,"units=deg C" 
RH,,"units=%" 
Speed,7.9,"units=m/s" 
Direction,92.0,"units=deg" 
Latitude,30.9909,"units=deg" 
Longitude,-119.5005,"units=deg" 
Altitude,19610.0,"units=m" 
Ascending,"false" 
Fields,Time,Pressure,Temperature,RH,Speed,Direction,Latitude,Longitude,
Altitude,Dewpoint,Uwnd,Vwnd,Ascent 
Units,sec,mb,deg C,%,m/s,deg,deg,deg,m,deg C,m/s,m/s,m/s 
Data,0.3,,,,,,,,,,,, 
Data,0.8,,,,,,,,,,,, 
Data,11.8,,,,11.52,69.53,,,,,-10.79,-4.03, 
Data,38.8,71.06,-60.33,,8.23,104.25,30.99129,-119.50375,18295.7,,-
7.98,2.03,-39.94 
Data,51.8,77.01,-63.75,,8.67,160.11,30.99174,-119.50441,17799.7,,-
2.95,8.15,-36.35 
Data,66.3,83.86,-62.29,,,,30.99267,-119.50520,17276.1,,,,-35.06 
Data,75.8,88.52,-64.99,,8.95,119.15,30.99295,-119.50592,16944.3,,-
7.82,4.36,-34.01 
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Appendix C: System Requirements 

Screen resolution: 1024x768 pixels or greater 

Windows display: configured for small fonts 
Free disk space: at least 20 MB  

Processor speed: 500 MHz or better recommended 
System memory: 256 MB RAM or greater 

Operating system: Windows XP 
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Appendix D: netCDF Attributes 

The following shows the output of an ncdump command applied to an Aspen generated 
netCDF  file.  
netcdf D20010801_175834QC { 
dimensions: 
 time = 2122 ; 
variables: 
 int base_time ; 
  base_time:long_name = "sounding launch time" ; 
  base_time:units = "seconds since 1970-01-01 00:00:00 UTC" ; 
  base_time:string = "Wed Aug 01 17:58:34 2001" ; 
 float time_offset(time) ; 
  time_offset:long_name = "seconds since base_time" ; 
  time_offset:units = "seconds" ; 
  time_offset:missing_value = -999.f ; 
  time_offset:_FillValue = -999.f ; 
 double time(time) ; 
  time:long_name = "time" ; 
  time:units = "seconds since 1970-01-01 00:00:00 UTC" ; 
  time:missing_value = -999.f ; 
  time:_FillValue = -999. ; 
 float pres(time) ; 
  pres:long_name = "pres" ; 
  pres:units = "hPa" ; 
  pres:missing_value = -999.f ; 
  pres:field_type = "P" ; 
  pres:_FillValue = -999.f ; 
 float tdry(time) ; 
  tdry:long_name = "tdry" ; 
  tdry:units = "degC" ; 
  tdry:missing_value = -999.f ; 
  tdry:field_type = "T" ; 
  tdry:_FillValue = -999.f ; 
 float dp(time) ; 
  dp:long_name = "dp" ; 
  dp:units = "degC" ; 
  dp:missing_value = -999.f ; 
  dp:field_type = "T_d" ; 
  dp:_FillValue = -999.f ; 
 float rh(time) ; 
  rh:long_name = "rh" ; 
  rh:units = "percent" ; 
  rh:missing_value = -999.f ; 
  rh:field_type = "rh" ; 
  rh:_FillValue = -999.f ; 
 float u_wind(time) ; 
  u_wind:long_name = "u_wind" ; 
  u_wind:units = "m/s" ; 
  u_wind:missing_value = -999.f ; 
  u_wind:field_type = "uwind" ; 
  u_wind:_FillValue = -999.f ; 
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 float v_wind(time) ; 
  v_wind:long_name = "v_wind" ; 
  v_wind:units = "m/s" ; 
  v_wind:missing_value = -999.f ; 
  v_wind:field_type = "vwind" ; 
  v_wind:_FillValue = -999.f ; 
 float wspd(time) ; 
  wspd:long_name = "wspd" ; 
  wspd:units = "m/s" ; 
  wspd:missing_value = -999.f ; 
  wspd:field_type = "wspd" ; 
  wspd:_FillValue = -999.f ; 
 float wdir(time) ; 
  wdir:long_name = "wdir" ; 
  wdir:units = "degree" ; 
  wdir:missing_value = -999.f ; 
  wdir:field_type = "wdir" ; 
  wdir:_FillValue = -999.f ; 
 float dz(time) ; 
  dz:long_name = "dz" ; 
  dz:units = "m/s" ; 
  dz:missing_value = -999.f ; 
  dz:_FillValue = -999.f ; 
 float range(time) ; 
  range:long_name = "range" ; 
  range:units = "km" ; 
  range:missing_value = -999.f ; 
  range:_FillValue = -999.f ; 
 float qp(time) ; 
  qp:long_name = "qp" ; 
  qp:units = "hPa" ; 
  qp:missing_value = -999.f ; 
  qp:_FillValue = -999.f ; 
 float qt(time) ; 
  qt:long_name = "qt" ; 
  qt:units = "degC" ; 
  qt:missing_value = -999.f ; 
  qt:_FillValue = -999.f ; 
 float qrh(time) ; 
  qrh:long_name = "qrh" ; 
  qrh:units = "percent" ; 
  qrh:missing_value = -999.f ; 
  qrh:_FillValue = -999.f ; 
 float qu(time) ; 
  qu:long_name = "qu" ; 
  qu:units = "m/s" ; 
  qu:missing_value = -999.f ; 
  qu:_FillValue = -999.f ; 
 float qv(time) ; 
  qv:long_name = "qv" ; 
  qv:units = "m/s" ; 
  qv:missing_value = -999.f ; 
  qv:_FillValue = -999.f ; 
 float qwind(time) ; 
  qwind:long_name = "qwind" ; 
  qwind:units = "m/s" ; 
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  qwind:missing_value = -999.f ; 
  qwind:_FillValue = -999.f ; 
 float mr(time) ; 
  mr:long_name = "mr" ; 
  mr:units = "gram/kg" ; 
  mr:missing_value = -999.f ; 
  mr:_FillValue = -999.f ; 
 float vt(time) ; 
  vt:long_name = "vt" ; 
  vt:units = "degC" ; 
  vt:missing_value = -999.f ; 
  vt:_FillValue = -999.f ; 
 float theta(time) ; 
  theta:long_name = "theta" ; 
  theta:units = "K" ; 
  theta:missing_value = -999.f ; 
  theta:_FillValue = -999.f ; 
 float theta_e(time) ; 
  theta_e:long_name = "theta_e" ; 
  theta_e:units = "K" ; 
  theta_e:missing_value = -999.f ; 
  theta_e:_FillValue = -999.f ; 
 float theta_v(time) ; 
  theta_v:long_name = "theta_v" ; 
  theta_v:units = "K" ; 
  theta_v:missing_value = -999.f ; 
  theta_v:_FillValue = -999.f ; 
 float lat(time) ; 
  lat:long_name = "north latitude" ; 
  lat:units = "degrees" ; 
  lat:missing_value = -999.f ; 
  lat:_FillValue = -999.f ; 
  lat:valid_range = -90.f, 90.f ; 
 float lon(time) ; 
  lon:long_name = "east longitude" ; 
  lon:units = "degrees" ; 
  lon:missing_value = -999.f ; 
  lon:_FillValue = -999.f ; 
  lon:valid_range = -180.f, 180.f ; 
 float alt(time) ; 
  alt:long_name = "altitude above MSL" ; 
  alt:units = "meters" ; 
  alt:missing_value = -999.f ; 
  alt:_FillValue = -999.f ; 
 
// global attributes: 
  :bad_value_flag = -999.f ; 
  :zebra_platform = "class" ; 
  :history = "ClassNcFile" ; 
  :AvapsEditorVersion = "2.3.1" ; 
  :SoundingDescription = "D20010801_175834.3 011118097 AAVAPS 
Flight Test, EAFB Flight Test 3 Lockheed ER-2, NASA 809" ; 
  :ACagency = "AF001" ; 
  :ACtype = "0" ; 
  :AbrHdrOvr = "0" ; 
  :AutoFile = "1" ; 
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  :BSN = "99999" ; 
  :BaudRateIndex = "2" ; 
  :CallSign = "CALL" ; 
  :ChuteArea = "676" ; 
  :CommPortIndex = "0" ; 
  :DoLevels = "1" ; 
  :DoQC = "1" ; 
  :DoWMO = "1" ; 
  :DropSondeMass = "395" ; 
  :DropsondeHitSfc = "1" ; 
  :ExcludeAbrHdr = "0" ; 
  :IcaoIndex = "1" ; 
  :MissionId = "TRAIN" ; 
  :MissionStorm = "WXWXA" ; 
  :OptIcao = "W" ; 
  :PlotFileFormat = "0" ; 
  :PlotPixelsX = "1000" ; 
  :PlotPixelsY = "700" ; 
  :PosInterpSpan = "60" ; 
  :PresBuddySlope = "2" ; 
  :PresOffset = "0" ; 
  :PresOutlier = "10" ; 
  :PresQCDev = "3" ; 
  :PresQCWL = "10" ; 
  :PresSmoothWL = "5" ; 
  :QCSaveDir = "C:\\tmp\\ER-2" ; 
  :RHBuddySlope = "20" ; 
  :RHOffset = "0" ; 
  :RHOutlier = "10" ; 
  :RHQCDev = "3" ; 
  :RHQCWL = "10" ; 
  :RHSmoothWL = "5" ; 
  :RHchoice = "0" ; 
  :RawSaveDir = "C:/" ; 
  :SetHtsMissing = "0" ; 
  :SfcAltUnknown = "1" ; 
  :SfcAltitude = "0" ; 
  :SkewTPlotSaveDir = "C:/" ; 
  :TdryBuddySlope = "3" ; 
  :TdryDynCor = "0" ; 
  :TdryOffset = "0" ; 
  :TdryOutlier = "10" ; 
  :TdryQCDev = "3" ; 
  :TdryQCWL = "10" ; 
  :TdrySmoothWL = "5" ; 
  :TempMsgType = "0" ; 
  :WindBuddySlope = "5" ; 
  :WindDynCor = "0" ; 
  :WindOutlier = "10" ; 
  :WindQCDev = "3" ; 
  :WindQCWL = "10" ; 
  :WindSats = "3" ; 
  :WindSmoothWL = "10" ; 
  :WindVVdelta = "2.5" ; 
  :WmoSaveDir = "C:/" ; 
  :XYPlotSaveDir = "C:\\tmp" ; 


